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Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication supersedes that in all
previously published material. Specifications and price change privileges reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.


http://www.tektronix.com/contact

Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; ¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category Il IlI, or IV circuits.

Power disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.
Replace batteries properly. Replace batteries only with the specified type and rating.

Use proper fuse. Use only the fuse type and rating specified for this product.

Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.

Provide proper ventilation. Refer to the manual’s installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in This Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product

These terms may appear on the product:

= DANGER indicates an injury hazard immediately accessible as you read the marking.

= WARNING indicates an injury hazard not immediately accessible as you read the marking.
= CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:

A @ + b

CAUTION Protective Ground X
RefertoManual ~ (Earth) Terminal ~ Chassis Ground  Standby
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Compliance Information

Compliance Information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1:2006, EN 61326-2-1:2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 1234

= CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
= |EC 61000-4-2:2001. Electrostatic discharge immunity

B |EC 61000-4-3:2002. RF electromagnetic field immunity 3

= |EC 61000-4-4:2004. Electrical fast transient/burst immunity

B |EC 61000-4-5:2001. Power line surge immunity

® |EC 61000-4-6:2003. Conducted RF immunity ©

E |EC 61000-4-11:2004. Voltage dips and interruptions immunity 7

EN 61000-3-2:2006. AC power line harmonic emissions
EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.

4 Atthe IEC 61000-4-11 Voltage-Interruption Transient Immunity test at 0% for 250 cycles, the EUT reboots and can take greater
than 10 seconds to recover.

5 Performance degradation information for the IEC 61000-4-3 test: Residual spurious signals can typically increase to -55 dBm with
exposure to the disturbance levels of this test.

6  Performance degradation information for the IEC 61000-4-6 test: Residual spurious signals can typically increase to the worse of
either 55 dB below reference level or -75 dBm, with exposure to the disturbance levels of this test.

7 Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels
(IEC 61000-4-11).
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Compliance Information

Australia / New Zealand Declaration of Conformity — EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

® CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.

Safety Compliance

EC Declaration of Conformity — Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:
Low Voltage Directive 2006/95/EC.

= EN61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
= UL 61010-1:2004, 2nd Edition. Standard for electrical measuring and test equipment.

Canadian Certification

B CAN/CSA-C22.2 No. 61010-1:2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use. Part 1.

Additional Compliances

® |EC 61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type

Test and measuring equipment.

Safety Class

Class 1 - grounded product.

Pollution Degree Description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

= Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

= Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.
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Compliance Information

m  Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

= Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Environmental Considerations - RSA6100A

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling
Central Web page (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.
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Compliance Information

Environmental Considerations - RSA5100A

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling
Central Web page (www.eiae.org) for disposal or recycling information.

Perchlorate Materials. This product contains one or more type CR lithium coin cell batteries. According to the
state of California, CR lithium coin cells are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.

viii RSAB100A Series & RSA5100A Series Quick Start User Manual



Preface

Preface

This manual describes the installation and basic operation of the RSA6100A Series of Real-Time Spectrum Analyzers and
RSA5100A Series Real-Time Signal Analyzers. For more detailed information, see the online help for your instrument.

RSAG106A
RSAG114A
RSAG120A
RSA5103A
RSA5106A

Key Features
The RSA6100A Series and RSA5100A Series are a family of high-performance real-time analyzers. Key features include:

Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault

DPX Density triggering to easily capture instabilities, transients and hidden signals that are impossible for other signal
analyzers to catch

Conventional spectrum analysis controls and functions including fast tuning, markers, phase noise, spurious and
other measurements

Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

Time domain triggering capability: Runt Triggers, Holdoff Trigger, and Time Qualification to all of the instrument triggers
(Option 200)

Multi-domain displays that provide an intuitive understanding of time-varying RF signals

Conventional Vector Signal Analysis capability available (Option 21) with modulation analysis for >20 popular modulation
formats

Seamless capture of signals in up to 110 MHz spans (RSA6100A Series) or 85 MHz spans (RSA5100A Series)

Documentation

The following documentation is available with your Tektronix RSA6100A Series Spectrum Analyzer or RSA5100A Series
Signal Analyzers. For the most current documentation, refer to the Tektronix Web site.

To read about Use these documents

Installation and operation Quick Start User Manual

(overviews) The quick start user manual contains general information about how to put your instrument
into service and guides to user interface controls.

In-depth operation and Online help

user interface help The online help contains detailed information about how to operate the instrument.

Application examples Application Examples Manual

This manual provides practical examples of using the analyzer to accomplish tasks.
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Preface

To read about Use these documents

Programming commands Programmer Manual
The programming commands for the RSA6100A Series and RSA5100A are located in a
PDF file located on the Documents CD.

Specifications and Specifications and Performance Verification Manual

performance verification This manual contains the instrument specifications and a procedure to check instrument
performance against warranted characteristics. This manual is in a PDF file located
on the Documents CD.

User service Service Manual.
A manual that provides a list of replaceable parts, care and maintenance information, and
information for servicing the instrument to the module level. This manual is in a PDF file
located on the Product Documentation CD.

Software Upgrades

Software option upgrades are available. Software upgrades for options become operational only after you enter a valid
option key for the specific analyzer model and serial number.

To check for upgrades:
1. Use your Web browser to go to www.tektronix.com/software.

2. Enter the product name (for example RSA6120A or RSA5106A) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

w00 00C
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

RSAG6100A Series Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), declassification and security instructions
(on CD), service manual (on CD), power cord, BNC-N adapter (RSA6106A and RSA6114A only, Tektronix part number
103-0045-XX), Jack-to-Jack SMA adapter (RSA6120A only, Tektronix part number 131-8508-XX) 50 Q SMA terminator
(RSAG6120A only, Tektronix part number 015-1022-XX), USB keyboard, USB mouse, and instrument front cover.

Documents

B RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual is available in the following languages:

English, Tektronix part number 071-2838-XX.

Simplified Chinese, Tektronix part number 071-2839-XX.
Japanese, Tektronix part number 071-2840-XX.
Russian, Tektronix part number 071-2841-XX.

B RSA6100A Series and RSA5100A Series Product Documentation CD, Tektronix part number 063-3930-XX.
The Product Documentation CD contains PDF versions of the following manuals:

RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User
Manual,
in English (this manual), Japanese, Russian and Simplified Chinese.

RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Application
Examples Manual,
Tektronix part number 071-2834-XX.

RSA6100A Series Real-Time Spectrum Analyzers, Printable Online Help,
Tektronix part number 077-0169-XX.

RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Programmer
Manual,
Tektronix part number 077-0523-XX.

RSA6100A Series Real-Time Spectrum Analyzers Service Manual,
Tektronix part number 077-0250-XX.

RSA6100A Series Real-Time Spectrum Analyzers Specifications and Performance Verification Manual,
Tektronix part number 077-0251-XX.

RSA6100A Series Real-Time Spectrum Analyzers Declassification and Security Instructions,
Tektronix part number 077-0170-XX.
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Installation

Power Cords

The RSA6100A Series Real-Time Spectrum Analyzers are shipped with one of the following power cord options. Power
cords for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved
by at least one authority acceptable in the country to which the product is shipped.

International Power Plugs

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

AO - North America power
A1 - Universal EURO power
A2 - United Kingdom power
A3 - Australia power

A4 - 240 V, North America power
A5 - Switzerland power

A6 - Japan power

A10 - China power

A11 - India power

A12 - Brazil power

A99 - No power cord

RSAB100A Series & RSA5100A Series Quick Start User Manual



Installation

RSA5100A Series Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), declassification and security instructions (on
CD), service manual (on CD), power cord, BNC-N adapter, USB keyboard, USB mouse, and instrument front cover.

Product Documentation

m  RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User
Manual is available in the following languages:

= English, Tektronix part number 071-2838-XX.

= Simplified Chinese, Tektronix part number 071-2839-XX.
= Japanese, Tektronix part number 071-2840-XX.

= Russian, Tektronix part number 071-2841-XX.

B RSA6100A Series, RSA5100A Series Product Documentation CD, Tektronix part number 063-4314-XX.
The Product Documentation CD contains PDF versions of the following manuals:

= RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User
Manual,
in English, Japanese, Russian and Simplified Chinese.

= RSAG6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Application
Examples Manual,
Tektronix part number 071-2834-XX.

= RSA5100A Series Real-Time Signal Analyzers, RSA6100A Series Real-Time Spectrum Analyzers Printable Online
Help,
Tektronix part number 077-0519-XX.

= RSA6100A Series Real-Time Spectrum Analyzers, RSA5100A Series Real-Time Signal Analyzers Programmer
Manual,
Tektronix part number 077-0523-XX.

= RSA5100A Series Real-Time Spectrum Analyzers Service Manual,
Tektronix part number 077-0522-XX.

= RSA5100A Series Real-Time Signal Analyzers Specifications and Performance Verification Manual,
Tektronix part number 077-0520-XX.

= RSA5100A Series Real-Time Spectrum Analyzers Declassification and Security Instructions,
Tektronix part number 077-0521-XX.

Power Cords

The RSA5100A Series Real-Time Spectrum Analyzers are shipped with one of the following power cord options. Power
cords for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved
by at least one authority acceptable in the country to which the product is shipped.
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International Power Plugs

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

A0 - North America power
A1 - Universal EURO power
A2 - United Kingdom power
A3 - Australia power

A4 - 240 V, North America power
A5 - Switzerland power

A6 - Japan power

A10 - China power

A11 - India power

A12 - Brazil power

A99 - No power cord

Optional Accessories

RSA6100A Series
m RSAB1RHD - Provides an additional removable hard disk drive for use with Option 06

= (065-0765-XX - Additional removable solid-state hard drive for use with Option 08
(Microsoft Windows XP Embedded and instrument SW pre-installed)

RSA5100A
RTPA2A - Real-Time Spectrum Analyzer Probe Adapter; Supports TekConnect probes P7225, P7240, P7260, P7330,

P7313, P7350, P7350SMA, P7380, P7380SMA.

RSAVu - Offline analysis software based on the RSA3000 platform for analysis supporting 3G wireless standards,
WLAN (IEEE 802.11a/b/g/n).

RSA-IQWIMAX, and RSALTE from LitePoint — Third-party solutions that enable WiMax and LTE analysis with the
RSA000 Series.

065-0xxx-00 — Additional Removable Hard Drive for use with Opt. 56 (Windows 7 and instrument software pre-installed).

Transit Case — Tektronix part number 016-1963-00.
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RSA6100A Series Options

You can add the following options to your analyzer:

Option 01 - Adds 10 MHz to 3 GHz Pre-Amplifier

Option 02 - Adds frequency mask triggering and RAM expansion

Option 05 - Adds digital IQ output and 500 MHz analog IF output

Option 06 - Adds a removable hard disk drive (not compatible with Option 07 or Option 08)
Option 07 - Adds a DVD+RW drive, no-cost option (not compatible with Option 06 or Option 08)
Option 08 - Adds a removable solid-state hard drive (not compatible with Option 06 or Option 07)
Option 11 - Adds Phase Noise and Jitter Measurement

Option 12 - Adds Settling Time Measurement (Frequency and Phase)

Option 20 - Adds advanced signal analysis (including pulse measurements)

Option 21 - Adds general-purpose digital modulation analysis

Option 110 - Adds 110 MHz real-time capture bandwidth

Option 200 - Advanced DPX and Triggers

RSA56KR — Rackmount for RSA5100A Series and RSA6100A Series analyzers
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RSA5100A Series Options

You can add the following options to your analyzer:

m  Option 11 - Adds Phase Noise and Jitter Measurement.

= QOption 12 - Adds Settling Time Measurement (Frequency and Phase).

m  Option 20 - Adds advanced signal analysis (including pulse measurements).

B QOption 21 - Adds general-purpose digital modulation analysis.

E  Option 40 - Adds 40 MHz real-time capture bandwidth.

=  QOption 85- Adds 85 MHz real-time capture bandwidth.

= Option 51 - Adds 10 MHz to 3 GHz Pre-Amplifier.

B QOption 52 - Adds frequency mask triggering.

= Option 53 - Adds Memory, 4 GB Acquisition Memory Total.

®m  QOption 56 - Adds a removable hard disk drive (not compatible with Option 57 or Option 59).
m  Option 57 - Adds a CD-R/W drive (not compatible with Option 56).

B QOption 59 - Adds a internal hard disk drive (not compatible with Option 56).

m  Option 200 - Adds Advanced DPX with Density, Time Qualified and Runt Triggers and Zero-Span.

®  Option 5040 — Combines Option 50 (Preamp) and Option 40 (40 MHz Acquisition BW). Mutually exclusive with
Options 50 and 40.

= QOption 5085 — Combines Option 50 (Preamp) and Option 85(85 MHz Acquisition BW). Mutually exclusive with Options
50 and 40.

B RSA56KR - Rackmount for RSA5100A Series and RSA6100A Series analyzers.
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Operating Considerations

Power supply requirements

Source voltage and frequency

Installation

Power consumption

100 — 240 Vrys, 50/60 Hz
115 VRMS, 400 Hz

450 W maximum (all models)

Environmental requirements

Characteristic

Description

RSA6100A Series Operating temperature

+5 °C to +50 °C (+5 °C to +40 °C; when accessing the DVD drive or optional
removable hard-disk drive)

RSA5100A Series Operating temperature

+10 °C to +40 °C

Non-operating temperature

-20 °C to +60 °C

RSA6100A Humidity 90% relative humidity at 30 °C (non-condensing)
80% maximum when accessing the DVD drive
Maximum wet-bulb temperature 29 °C
RSA5100A Humidity 90% up to 30 °C (non-condensing)
80% relative humidity maximum when accessing the DVD drive
Above 30 °C it is limited by maximum wet-bulb temperature 29 °C
Altitude:
Operating Up to 3000 m (9843 ft)

Non-operating

12190 m (40,000 t)

Cooling clearance
Bottom
Sides and back

20 mm (0.79 in)
50 mm (1.97 in)

RSAB6100A Series & RSA5100A Series Quick Start User Manual



Installation

20.901in

- (530.86 mm)

11.11n

(282. mm)

5 © © ©

000000000
000000000
OO0O000000

00000000000 OOOO0000000000
00000000000 OO000000000000
OO000000000 OO0O00000000000

000000000
000000000
[

1 o6
L]

RN —

U 1909-005

CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting
on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the spectrum analyzer. The instrument is

somewhat heavy and requires extra care when moving it.

Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with

USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘

network for printing, file sharing, Internet

access, and other functions. Consult your ———

network administrator and use the standard SSiS !

Windows utilities to configure the instrument cacse 23;

for your network. || ||S555. 23 7

Quick Tip

= |f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing

regular approved operating system updates, and using up-to-date antivirus software.
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Powering On the Instrument
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Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the analyzer and the second
monitor must have the color set to True Color.

1. Power off the analyzer and the external d )
. ————
monitor.

2. Connect the external monitor to the
analyzer.

3. Power on the analyzer and the external
monitor.

1909-013
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4. Open the Windows Control Panel.

5. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

B Control Panel

File Edit Wiew Favorites Tools Help

eBack - @ tﬁ pSaarch ltj Folders v [r

Installation

Address B‘ Control Panel

V‘Go

Mame =
Qpnccessmlllty Options
& add Hardware
[LAdd or Remove Programs
@ administrative Tools

ﬂ’ Control Panel k]

@ Switch to Category Wiew

Comments [~ |
Adjust your comput
Installs and trouble
Install or remove pr
Configure administr 1

& sutomatic Updates Set up Windows ta

See Also “PDate and Time Set the date, time,
‘ Windows Update &D\splay Change the appear
e | Folder Options Customize the displ
(DI R DTl e EYFonts Add, change, and .
& Game Contrallers Add, remove, and ¢
T Inte i Control the graphic
fInternet Cptions Configure your Inte
Customize your key
Customize your mo

v

Commasbe ko by o

& .

1909017
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6. Click Intel(R) Dual Display Clone to

Intel(R) B2852/82855 GMIGME Graphics Controller Prope... [ ][]

show internal screen (Notebook) content o B
f : evices
on an externa| momtor (Momtor). olor chemes | Hot Keys | Rotation | Open nformation
T Settings
“.é Colors ’m
Manitar
1 Screen Area 800 by 600 -
<
Motehook, Refresh Rate 'm
EE |
\ntel[}.:ﬁ.l.:,lual @
Dizplay Clone
i
44
Extended Desktop
oK | Cancel Apply

1900-018

7. Adjust the settings as necessary and
then click OK to apply the settings and to
close the properties page.

Devices ]Eolor ] Schemes] Hat Keys] Hotation] DpenGL] Informatinn]

Extended Desktop Settings

E|

=

M anitar

1 2
Motebook.
Frimary Device Moteboaok 7
=

= =_I Secondary Device tanitar -
Intel[R] Dual
Dizplay Clone

E stended Deskiap Device Settings...

@

’_ Uk | Cancel Apply

1903019
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Adjusting the Windows Display Settings

Installation

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.

1. Open the Windows Control Panel.

2. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

3. Adjust the settings as necessary.

NOTE. Not all of the selections in the
property page will be available if there is no
external monitor connected to the instrument.

4. Click OK to apply the settings and to
close the properties page.

#- Control Panel
Edit

File

@ Back ~ \J

View Favorites Tools Help

{’ /71 Search |{ Folders v 1'f‘

Address | Control Panel

v .Ga

Name =
&Accessibility Options
& Add Hardware
{L)Add or Remove Programs
48 Administrative Tools
“ Automatic Updates
j’Date and Time
}Display
| Folder Options
\fijnnts

‘& Game Controllers

&" Control Panel ]

G Switch ko Category Yiew

See Also

Q Windows Update
(7)) Help and Support

p
@mKeyboard
) Mouse

[ VYN e

Comments o]
Adjust your comput
Installs and trouble
Install or remove pr
Configure administr
Set up Windows to
Set the date, time,
Change the appear
Customize the displ
Add, change, and .
Add, remove, and ¢
Control the graphic
Configure your Inte
Customize your key
Customize your mo

P T PRI

Intel(R) 82852/82855 GM/GME Graphics Controller Prope... [2)(X]

Devices | Calor I Schemes | Hot Keys | Hotationl UpenGL' Informationl
Settings
'd ]
— Calors True Color -
Manitor
7 Screen Area 800 by 600 -
Natebaok. Refresh Rate B0 Hz -
4
Intel(R) Dual
Display Clone
44
Estended Desktop
®
|— 0K I Cancel Apply

1909-111

1909-110

NOTE. Although it is not recommended, you can aftach a second monitor after the analyzer is powered on; however, after
connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control panel.
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Inspecting the Instrument

Run the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA6100A Series Real-Time
Spectrum Analyzers Specifications and Performance Verification Technical Reference manual PDF (Tektronix part number
077-0251-XX) or RSA5100A Series Real-Time Signal Analyzers Specifications and Performance Verification Technical
Reference manual PDF (Tektronix part number 077-0520-XX) located on the Product Documentation CD.

1. Select Tools > Diagnostics. [Took |
3 search...

Alignments...

| Diagnostics l @

Install Upgrades. ..

Options

1903020

2. Onthe Diagnostics tab, click All | Tek RSAG100A - [Diagnostics] [A=ET]
Modules, All Tests. - %

2 TestProgress :k@
3 C||Ck Sing|e Test Dlagﬂﬂﬁtltﬁun Self Tests | Diagnostics Failure Info

= [J@ All Modules, All Tests
®

RUN

4. Click RUN. 2B Comears

. . # [] RFInterface q
The instrument will run through # [  Refererce osllator purrent eres
the tests one at a time. A check O e e T
mark or X icon will appear to the = Time: 755 1
right of each check box as that et o B
test is completed. The check icon D o Ot B B
means the test was passed. The D Gl Fai
X means the test was failed. il e @ Ocanrunus

@single Test

5. For tests that require manual

intervention, follow the on-screen

instructions to complete the tests.

1900-021

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (a subset of the Administrative tools in the Windows Control Panel) to view failure history and nondiagnostic failures
reported by the application.
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User Maintenance

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

/ ' \ cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software

Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument
If you return your instrument to Tektronix:
E  Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

= When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

= Seal the shipping carton with an industrial stapler or strapping tape.
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

@

@

-

@I

| Displays
Spectrum

-
e o1 (30)

(D
O

Left: RSA6100A series, right: RSA5100A series

l

S
@dﬁg 5)
® -

1

Trigger
Arm

Ready
Trigd

2838004

Ref number Item Description Menu equivalent
1 Media DVD+RW drive, removable hard disk drive, or removable
solid-state hard drive.
2 Displays Opens the Displays dialog box to select measurement Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected display. Setup > Settings
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab 2
8 Span (Spectrum) Adjusts the span or frequency range shown in the Spectrum Setup > Settings >
display. ! Freq & Span 2
9 Amplitude Adjusts the reference level. Setup >
Amplitude 2

16
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Ref number Item Description Menu equivalent
10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup > Settings >
BWtab 1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

s
o
m
@
S

= 0
= e

‘X KX

Seed) T — NN
7@ e (el (P
@ Demne) | (<h ﬂE) Deletey J D @
AN | h .
ez O
— —

Left: RSA6100A series, right: RSA5100A series

2838-006

Ref number Item Description Menu equivalent

1 Tab Moves the cursor to the next entry in the dialog box or
control panel. Same as pressing the Tab key on an external
keyboard.

12 Run (Stop) Push to start and stop acquisitions. Run > Run

13 Markers, Peak Moves the active marker to the maximum peak of the trace
in the selected display. If markers are turned off, the MR
(marker reference) marker will appear at the maximum peak.

14 Markers, Select Selects the next marker.

15 Markers, Define Opens the Markers control panel.

16 Esc Exits dialog boxes without saving changes.

17 Control knob Increments/decrements numbers with fine resolution.

18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow moves
the selected marker 10 trace points to the left. The left and
right arrows move the selected marker to the next peak.
(Turning the knob moves the marker one trace point left or
right.)

19 Increment / Increments or decrements numbers with coarse resolution.

decrement keys

20 Markers, Delete Deletes the highest-numbered marker.

21 Markers, Add Adds a marker to the selected trace.

22 Replay Replays the current acquisition record.

23 Single Sets the Run mode to Single Sequence and initiates a single

sequence acquisition cycle.

RSAB6100A Series & RSA5100A Series Quick Start User Manual
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18

Bksp
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2838009

Ref number Item Description Menu equivalent
24 Keypad Enters values in controls.
25 Enter Completes the data entry in controls. Same as pressing the

Enter key on the keyboard.

Touch Screen

Off ( Preset ‘

2838-002

Left: RSA6100A series, right: RSA5100A series

Ref number Item Description Menu equivalent
26 Recall Opens the Recall dialog box. File > Recall
27 Save Saves working file using the same user selections as for the File > Save
previous Save action.
28 Touch Screen Off Turns the touch screen on and off.
29 Help Displays the online help. Help >
User Manual
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Ref number Item Description Menu equivalent

30 Print Opens the Print dialog box. Printouts are a screen capture File > Print
of the analyzer application window.

31 Application Opens the Application preset dialog box. You can change Setup > Preset
the effect of pressing Application using the settings at Setup
>More presets > Preset Options > Preset type/action.

32 DPX For instruments with Option 200, opens swept DPX over Setup > More
the full frequency range of the instrument. For instruments Presets >
without Option 200, opens the DPX display over the Application
maximum real time acquisition bandwidth of the instrument.

You can change the effect of pressing DPX using the
settings at Setup > More presets > Preset Options > Preset
type/action.

33 User Opens the User preset dialog box. You can change the Setup > More
effect of pressing User using the settings at Setup > More Presets > DPX
presets > Preset Options > Preset type/action.

34 Preset Resets the instrument to its factory default settings. Youcan ~ Setup > More

change the effect of pressing Preset using the settings at
Setup > More presets > Preset Options > Preset type/action.

Presets > User

RSAB6100A Series & RSA5100A Series Quick Start User Manual
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Front Panel Connectors

oOOoOO o O
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Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High> 2.0V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, 2.5 V to +2.5 V range,
trigger level is user adjustable
3 USB port USB 1.1 mouse connector on RSA6100A, USB 2.0 on RSA5100A
4 USB port USB 2.0 connector
RF Input RF input connector 50 Q
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Rear Panel
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1909-011

RSA6100A series

Ref number Connector, Description

1 AC Input, main power connector

2 GPIB

3 IF output (Option 05)

4,5 Real Time 1Q Out (Option 05)

6 Ref In, reference frequency input

7 Ref Out, reference frequency output

8 Headphone, audio output connector

9 External Trigger 2 Input

10 COM 2, serial port for connecting peripherals
" VGA, external monitor output (resolution not limited to VGA)
12 PS2 Keyboard input

13 USB2 ports for mouse and other USB2 devices
14 TekLink, reserved for future use
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22

Ref number Connector, Description
15 +28 VDC Output, (switched)
16 LAN, Ethernet network connector

=
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RSA5100A series

Ref number Connector, Description

1 AC Input, main power connector

2 GPIB

3 LAN, Ethernet network connector

4 USB2 ports for mouse and other USB2 devices
5 PS2 Keyboard input

6 VGA, external monitor output (resolution not limited to VGA)
7 COM 2, serial port for connecting peripherals

8 External Trigger 2 Input

9 Line In, Line Out, and Microphone connectors
10 Ref In, reference frequency input

11 Ref Out, reference frequency output

12 +28 VDC Output, (switched)
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Interface and Display Elements

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.

©POOOOO @ (9) (9 (1)

1 rgersastoy -oexppectr J /. p ] | | ¥

Gle  View | Run Markers  (Setup | Tools | Window  Help - 82 X
F[—maa [arkers |[settings ) Trig J[ Aca | ana | © Freq: 91.49 MHe > RefLev:-50.00 dBm [amp] [Run]
S ~ Bitmap [“IShow  On Clear
© 50,08 dBrn
o dBfdiv:
4,20 dB
Y REW
100 by
-92.00 dBm : R i | ! | _
o CF:91.49 MHz ¥ Span: 9.67 MHz
Analyzing Acg By 10,00 MHz, Acq Length: 89,120 us Real Time | Free Run Ref: Int  Atten: 10 dB

1903022
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@Q@@@@@@@@ ® (9 @

File | Viey  Fun / Rewvay ~Mzi&ers Setup Tool/ Window Help

H 5 & & T % & 1A Frequengy: 1.50000 GHz RefLev: 0.00 dBm Presetl | B Replay -~ | ) Run -
S 12 1of 10 Clear
% 0.00 dBm
o dB/div:
10.0 dB
LA1 UA1
-66.91 dB 3 83 dBm -66.04 dB
I||I.I|rllll 7 ‘ ‘ “ ;
;LN me M,f‘ ‘
-100.00 dBm f
© Pos: 1.50000 GHz © Scale: 5.16 MHz
Avg Channel | ch  Offset Lower Upper
Power (Main):
3.82 dBm Al 2.000 MHz -66.91 dB -66.04 dB
Stopped Acg BW: 20.00 MHz, Acg Length: 99.360 us Real Time Free Run Ref: Int Atten: 15 dB
Ref number Item Description
1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.
Markers Opens or closes the Marker toolbar at the bottom of the window.
3 Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.
Trigger Opens the Trigger control panel so that you can define the trigger settings.
5 Acquire Opens the Acquire control panel so that you can define the acquisition settings.
Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.
7 Measurement Displays the Measurement Frequency. To change the value, click the text and
Frequency use the front panel knob to dial in a frequency. You can also enter a frequency
with the front panel keypad or use the front panel up and down buttons.
8 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.
9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.
10 Replay Runs a new measurement cycle on the existing acquisition data record using

any new settings.
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ltem

Operation

Description

"

Run

Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.

You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select

Continuous, the instrument will run continuously until you stop the acquisitions.

12

Check Mark indicator

The check mark indicator ( v ) in the upper, left-hand corner of the display
indicates the display for which the acquisition hardware is optimized. When
Best for multiple windows is selected in the Amplitude control panel's RF & IF
Optimization control, none of the measurement displays shows a checkmark,
as there is not a single optimized measurement.

13

Displays the Open dialog box so you can recall a setup file or an acquisition
data file.

14

Opens the Save As dialog box so you can save a setup, screen capture,
acquisition data file, or export results or settings.

15

Preset

Displays the Main Presets dialog window or recalls Preset (Main), depending
on current settings.
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Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

ﬂ File  Wiew | Run  Markers Setup  Tools  Wirdow  Help -
Displays | | Marlers [Settings” Trig ” Acq ” Ana ] 2 Freq: 91.49 MHz % RefLey: -50.00 dBm
Ve v EBitmap [¥]Show  On Clear
& -50.00 dem
< defdiv:

6.00 dB
~ REW

100 kHr

®

-110,00 dBrm

¢ CF: 91,48 MHz & Span; 9.67 MHz

1909023

Table 1: Common icons

Ref number Control icon Description
1 s Drop-down List. Click to select a value from the drop-down list.
2 ] Knob. Click anywhere on the icon or on the text readout to select the control. You

can then change the value with the front panel control knob or arrow keys, or enter a
value from the keypad.

3 6.337us Italicized numbers. These indicate automatically selected control values. Several
controls in the instrument (for example, RBW and Analysis Length) allow you to
select an Auto mode. In Auto mode, the instrument software automatically sets the
value. You can change the control to Manual mode by changing the value. To return
to Auto mode, clear the value, and then press the Enter key.
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Basic Concepts

Real Time Analyzers

Tektronix real-time analyzers, such as the RSA6100A Series Analyzers and RSA5100A Series Real-Time Analyzers, have an
optional frequency mask trigger. The frequency mask trigger allows you to set up a spectral mask to capture a signal when a
spectral anomaly occurs. This allows the real-time spectrum analyzer to check 100% of the input signal before acquiring, and
then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events. Option 200 includes the ability to measure and trigger on signal density values in the
DPX display.

The RSA6100A Series Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers allow you to view the
captured signals in a wide variety of time-correlated displays. This is useful for device troubleshooting and signal
characterization applications. All of the measurements, other than the DPX display, are based on the same underlying
set of time domain sample data.

Measurement Displays

The analyzer window can show one or any combination of general purpose and application-specific displays.

This example shows a single DPX Spectrum 7\ Tek RSAG100A - [DPX Spectrum] [BEE
d|Sp|ay W|th|n the WmeW B Fle tiew Run  Markers Setup  Tooks  Window  Help -
Displays | | Markers ||Settings || Trig || Acg || Ana | © Freq: 91.49 MHz ~ RefLey: -50.00 dBm
< v Eitmap  [FShow  on
© -50.00 dBm
< dBfdiv:
6.00 dB
¥ RBW
100 oz
| i
i 3
2n00dem SRR i ! f § | ol ¥ AT
o CF: 91.49 MHz © Span: 9.67 MHz

1909024
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This example shows the window with two
displays, a Spectrum display and a DPX
spectrum display.

When you have more than one display
open, the display with the check mark icon
has control over the acquisition hardware.
To give a display priority over any others,
click its title bar.

This example shows four displays in the
window.

'\ Tek RS461004 [BEES
File  Views Run  Markers  Setup  Tools  ‘window  Help
Dlsp\ays M Settings EEE ' Freq: 91.49 MHz <~ RefLey: -50.00 dBm m -

m ' - |

~ Bitman  [IShow  ©On v Trace 1 [YIShow

© -50.00 dem < -50.00 dem
© dBfdiv: © de/div:
6.00dB 10.0dB
~ REW “ REW
100 kHz 50 kHe

f ﬂ"i"‘ ”]M‘\

-11000dem ||

Autoscale

RiR ) 1 | =000 cEm
o

Autoscale

% CF: 01.43 MHz

‘ Il ” 1

_[E— ]

+Peak MNormal

r‘ “”ll‘ #M ]‘[]

o Span: 9.67 MHz

Markers v MR

Frequency % |91.485487 MHz

(o) (72 O 0 &) () () )

4nalyzing Acq BY: 10,00 MHz, Acq Length: 89,120 us Real Time  Free Run Ref: Int  Atten: 10 dB Preamp
1909025
L Tek RSA6100A [BEE
Fle View Run  Markers Setup  Toos  Window  Help
| Displays | | Markers ||Settings || Trig || Acg || Ana | © Freq: 91.49 MHz ~ RefLey: -50.00 dBm

o] st CER
 Eitmap  [Show  on (A= (57 ] [#600s Actual: 44,560 Us
© 50,00 dem i —
% 50,00 dBm I TR
< dBydiv:
6.00 dB < dB/div:
10.0 d
Y RBW
100 ke
-110,00 dBm Th6 'R AT =
Autoscals 2 CF: 9149 MHz [Autoscale | o position: 0,000 5 % Scale: 89,120 us
7 w [Trace [Vshow Mormal w Trace 1 [“Ishow  +Peak Normal -
© 1.09 my © 50,00 dBm
) J < dBydiv: i
! F'l"r”' H HF .| Ei S
© Pogition: 4 | et \ .. - i ‘
130 uv J 3
v [ I 'l 50 4tz || lll U” ‘ ‘ ' h w
p o il |i -l 1 r |'||l
831 v
@ Pasition: 0,000 5 v Scale: 44,560 us -150.00 dBm
Max: 943.6 UY @ 13545 Min: 232409 @ 39.19us © CF: 51,49 MHz  Span: 0.67 MHz
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The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays

The RSA6100A Series and RSA5100A Series analyzers use multiple displays to keep operations simple, and yet provide
advanced functionality when needed. Some of the display categories include:

General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

Analog Modulation. These displays show graphs and measurements for Analog Modulation, Frequency Modulation,
and Phase Modulation.

General Purpose Digital Modulation displays. Available with Option 21, General Purpose Modulation Analysis.
These displays show the results of demodulating signals and analyzing them in multiple domains. Examples of these
displays include: Constellation, EVM vs Time, Eye, Symbol Table, and Trellis diagrams.

RF Measurements displays. These displays show the results of automated measurements on RF signals. Examples of
these displays include: ACPR, MCPR, Phase Noise, and CCDF.

Pulsed RF displays. Available with Option 20, Advanced Signal Analysis. These displays show the results of advanced
analysis for pulsed RF signals. Examples of these displays include: Pulse Statistics, Pulse Table, and Pulse Trace.
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Selecting Displays

The analyzer provides an easy way to select displays.

30

1.

Click Displays to open the Select
Displays dialog box.

I\ Tek RSA6100A - [Spectrum]

File Wiew Run  Markers Sstup  Tools  Window  Help -8 x
|D\splays Markers ||Settings || Trig || Acg || Ana | © Freq: 91.49 MHz < Refley: -50.00 dBm

1909027

Bl Tek RSAS100A - [Channel Power and ACPR

File View Run Replay Markers Setup Tools Window Help .8 x
5@ & T % &% IR | Frequency: 150000 GHz

Reflev: 0.00 dBm PR | W Replay - | D) Run

2838011

There are two ways to select displays: choose any combination of displays or use an Application Preset.

Choose any Combination of Displays. Select displays one by one as needed.

1.

Click the desired application folder
in the Select Displays dialog box.
The available displays for each

folder are listed in the Available
Displays pane.

Click one of the display icons.

Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.
Repeat the procedure to add other
displays.

Click OK to close the dialog box.
The selected displays will open.

1 Select Displays

Choose any combination below, oruse an App\@eset Application Presets...

Folders: Available displays:

Analog Modulation
GP Digital Modulation
RF Measurements
Pulsed RF

Amplitude vs DPX Frequency  Phase vs
Time Spectrum s Time Time

" @
Selected displays:

RF 1&Q vs Spectrogram Time

Time Overview
Spectrum @

(5] (o=

1909140
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Use an Application Preset. Select displays from the presets for your application.

1. Click Application Presets in the Select
Displays dialog box.

2. Select one of the presets.

NOTE. Some presets appear only if the
associated instrument option is installed.

3. Click OK to close the dialog box. The
preset displays will open. (See Table 2.)

Table 2: Application presets

Presets

71 Select Displays EEx
Choose any combination below, or use an Application Preset, Application Presets... .——‘
Folders: Available displays:

Anzlog Modulation

GP Digital Modulation

RF Measurerments Ampltude vs Frequency  Phasevs  RFI&Qvs
Pulsed RF Time vs Time Time Time

0 ®

Spectrogram Time
Overview

1900-141

] Application Presets

Spur Search Multi Zone 9k-1GHz e—| '

Modulation Analysis
Pulse Analysis

Spectrum Analysis
Time-Frequency Analysis

To go directly to a preset in the future, use Tools-=0Options-=Presets-=Preset action

[_D!(_] Cancel

2838012

Displays

Modulation Analysis (Option 21 only)

Constellation, DPX Spectrum, Signal Quality, Symbol Table

Pulse Analysis (Option 20 only)

DPX Spectrum, Pulse Table, Pulse Trace, Time Overview

Spectrum Analysis

Spectrum

Spur Search Multi Zone 9k-1GHz

Spurious

Time-Frequency Analysis

Frequency vs Time, Spectrogram, Spectrum, Time Overview
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Quick Tips

m  Push the Displays button on the front panel to open the Select Displays dialog box.

B To add a display, double-click the icon.

= To remove displays, do one of the following:

= Select a display icon in the Selected Displays list, and then click Remove.

= Double-click a display icon in the Selected Displays list.

= Click the Close button in the upper right hand corner of the selected display.

®  You can mix displays from multiple application folders.

Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 3: Common information messages

Message

Explanation and recommended action

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

= Adisplay other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

B The data is from a recalled file.

There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW

When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.
Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.

RBW increased to 100 kHz

The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.
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Changing Measurement Settings

Operation

The displays have settings that control how signals are acquired and processed. The settings that you can change depend

on the selected display.

To access the settings (in this case, for the Spectrum display):

1. Click Settings to open the Settings
control panel.

2. Adjust the controls as needed for your

Spectrum

“JL Tek RSA6100A - [Spectrum] [BEE]

Bl Fie view PRun  Markers Setup Tools  Window  Help -8 x

| Warkers |(Settings |[ Trig |[ Acg |[ Ara | © Freg: 91.49 MHz = RefLev: -50.00 dBm
1909029

@

Freg & 5pan | BwW | Traces | Scale | Prefs

. Settings

signal or test. For example, use the Conter T2 TT0 o . prme —
enter: R iz an:| . MHz Max Span

Freq & Span tab to set frequency and 5= (EYET

span. Most of the control panels have Stop{ 1246140 Gz

tabs that provide easy access to other Step Sizal 2.0000 M auto

related controls.

1908-080
3. You can change the appearance of the A Tek RSA61004 — [Spectrum] AED]
d|3p|ay screen in the Prefs tab. Not all File View FRun Markers Setup Tools Window Help _ 8 x
of the following controls apply to every Sline O e
display. Some displays have additional I et
controls not described here. © .
o RBW:
= To turn on or off the graticule, select sk
the Show graticule check box. AN ¥
T
IR
= To turn on or off the marker readout, R 4
select the Show Marker readout in > CF: 150000 Gh © Span 40.00 Mz
graph check box. gSf:.:;:' Freq & Span | BW | Traces | Scale | Prefs @ @
Show: | Center, Span v Trace points: 801 b
= To turn on or off the trace legend,
Se|eCt the ShOW trace Iegend CheCk [¥]Show graticule [“]show Marker readout in graph (selected marker)
box. = s e aend Ay
Markers ~ MR Frequency v |15 GHz [¢J[*) x]
Stopped Simulated data SIM_NB.igt, SIM_WB.igt Real Time Free Run Ref: Int  Atten: 25 dB
1909-143
Quick Tip

B [f you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control

panel for that display.
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument (] )
settings, push the Preset button on the | |
front panel or select Preset from the
Setup menu.
Tab Esc
Spectrum Markers
o
@ |®
O
Bksp
D G (=
@ @ G @w
©@®® ]
x1/dBx  Enter ouch Screen
OO®®® | O
~ 1909-014
Quick Tip

B Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.
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Connecting a Signal

The analyzer has a single RF signal input located on the front panel. Make sure that you observe the input signal
requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any

A electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables aftached to the instrument with
the other ends of the cables open.

Required Signal Levels

The following table shows the input signal levels over which the analyzer can be used for measurements. The accuracy is
guaranteed at a signal amplitude and frequency (normalization point). Measurements can be made on signals within the
entire range of allowable inputs, but the accuracy of the measurement is affected by the frequency and amplitude of the
signal to be measured (see the RSA6100A Series or RSA5100A Series data sheet for more information).

RF signal input range (CW or peak envelope power)

Modulation measurement requirement Spectral display requirement
-50 dBm to +30 dBm DANL to +30 dBm

Input signal requirements

Characteristic Description

Input impedance 50 Q

Input frequency range
RSA6106A 9 kHz t0 6.2 GHz
RSA6114A 9 kHz to 14 GHz
RSA6120A 9 kHz to 20 GHz
RSA5103A 9 kHz to 3 GHz (RF Band)
RSA5106A 9 kHz to 6.2 GHz (RF Band)
RSA5103A/RSA5106A 1 Hz to 32 MHz (LF Band)

Maximum measurable continuous input power 1 W (+30 dBm)

Maximum voltage rating RSA6100A: +40 V DC, AC coupled

RSA5100A - +5 V DC, AC coupled

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). For the

A RSA6100A Series, the maximum voltage rating is +40 V DC. The maximum pulse specifications are 75 W peak, 10 us pulse
width, 0.001 duty cycle, and 230 dB attenuation. For the RSA5100A Series, the maximum voltage rating is £5 V DC. The
maximum pulse specifications are 50 W peak, <10 us pulse width, 0.001 duty cycle and 230 dB attenuation.
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To connect an RF signal:

1. Connect the signal to the RF INPUT
connector on the front panel.

Quick Tip

[enlen}anlenfan]
cooco O O
coocoo O O

L]
@ 1909015

= |f the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator

output to the RF Input connector.

Starting and Stopping Acquisitions

1. Click the Run button to start an
acquisition.
While acquiring data, the button
label has green lettering.

2. Click the Run button again (Stop
button on the RSA5100A Series
analyzers) to stop an acquisition.
If an analysis is in process, it will
finish its sequence and then stop.
The button label changes from
green lettering to black lettering
to indicate that the instrument has
stopped.

Quick Tip

) Tek RSAG100A - [Spectrum] [BEET
File Wiew Run  Markers Sstup  Tools  Window  Help 8 x

| o Freq: 91.49 MHz © Reflev: -50.00 dBm Ren

) Tek RSAG100A - [Spectrum] [BEET
File Wiew Run  Markers Sstup  Tools  Window  Help 8 x

1908031

© RefLey: -50.00 dBm | Run

@

= Push the front panel Run button to start and stop acquisitions.

Run Control

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to

the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.
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Markers

Operation

Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure

the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.

1. Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

2. Select Add Marker from the
drop-down list on the Marker
Toolbar.

The first marker is designated
the marker reference (MR).

3. Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

4. Read the frequency and power
level from the marker readout on
the display.

I\ Tek RSA6100A - [Spectrum]

B Fie wiew FRun  Makers Setup  Tools  Window  Help

BEE

o 1=

| Markers “ Freq: 91.49 MHz

© RefLev: -50.00 dBm

@

1909032

Define Marker Properties | Define Paaks
Markers R
Referance Delta Markers
d Marker: y w1 m2 M3 M4
Attach to:
(in selected
display)
Readouts: | Delta 4
Add Marker
Delete Marker
Markers Al markers off
Analyzing Acg BW: 40.00 MHz, Acg Length: 4.440 us Real Time | Free Run Ref: Int | Atten: 15 dB
1900033
| 71 Tek RSAG100A - [Spectrum] [BEES
B0 Fie  view kers  Setup  Tools  Window  Help -8 x
‘ Displays m DMEE % Freq: 91.49 MHz “ RefLev: -50.00 dBm
w Trac| 1 [FlShow  +Paak Marmal
© 50,00 dBm
< deydiv;
10.0 d&
“ RBW
50 kHz
\ ft ‘ ‘|
| | M HM RN
” ﬂ. i ‘} J‘\
-150.00 derm
& (F: 91,49 MHz % Span: 9.67 MHz

Markers v MR

Frequency v |ENREIE
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Markers Display

m Rectangular markers show absolute values in the readout. The readout of the selected marker appears in the upper left

corner of the display and in the Marker toolbar.

= Diamond markers show delta values (relative to the reference marker). The delta readout of the selected marker appears
in the upper right corner of the display and in the Marker toolbar.

= When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace

points, the marker finds the highest point.

B When you attach the marker to the bitmap trace in the DPX spectrum display, the marker readout indicates the hit count
for pixels (maximum 65,536) along with frequency and power (see the following figure). You can position the marker

at any point in the graph.

m  |f Option 200 is installed, markers attached to the DPX bitmap display the signal density in percent at the selected pixel,

rather then the hit count.

")\ Tek RSAG100A - [DPX Spectrum]

m File Wiew PRun Markers Setup Toolz  Window  Help

‘[Displays ] [Markers “Settings” Trig H Acq " Ana ] © Freq: 1.50C

& v +Peak Tr [¥]Show +Pk Normal
2 [0.00 dBm

< de/div:
10.0 de

o RBW:
400 -z

Quick Tips

= |f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

= Click Table in the Marker toolbar to open a tabular display showing the marker information.
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 4.) Some of these controls are similar to those
on the front panel.

Table 4: Marker toolbar

Description

Opens the Define Markers control panel. Use the control panel to add and remove markers and

Define
to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the selected marker. This

To Center
button is only present when the selected display has frequency on the horizontal axis.

Moves the marker to the maximum peak level on the trace. The maximum peak can be either the
highest or the lowest point in displays with both positive and negative values on their vertical axis
(such as Frequency Error or Phase).

Peak

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-lower-amplitude density peak at the same frequency.

Moves the selected marker to the next higher peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-higher-amplitude density peak at the same frequency.

Table Opens or closes the marker table in the display.

I B E|3|E III_

Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.
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Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers | Markers [Dafine | v ML |Frecuency v [20M: B ] |
control panel. g~
USG the Contr0| panel tO azii::rs Marker Properties | Define Peaks
Reference Dielta Markers
®  Add or delete markers. oo e - e e "
Attach to: Tracel ¥ Tracel %
®  Turn markers off. o
Readouts: |Delta hd
u Assign markers to specific traces. R oMl [Frequency (W20 M olola ]
1909-03¢

m  Set the marker readouts to absolute or
delta.

m  Define the threshold and excursion
values.

Quick Tip

B You can add or delete markers from the drop-down list next to Define in the Marker toolbar.

Touchscreen Actions

40

You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Some selections in the Touchscreen Actions IE P
menu are selectable only when a marker is ol spanz
. an L00m
defined. P
+»  CFPan
@\ Zoom
1'1:",? Pan
Reset scale

Marker to peak
MNext peak 3

Add marker
Delete marker

All markers off

Trigger On This

Touchscreen Actions menu
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Table 5: Touchscreen actions menu

Icon

Menu item

Operation

Description

Select

Selects markers and adjusts their position.

Span Zoom

Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.

Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan

Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings to their default
values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Positions the DPX Density measurement box at the click point, measures the
current signal density, sets up the DPX Density Trigger function based on the
measurement result, and starts acquisitions.
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1.

42

Push the Print button on the front panel
or select Print from the File menu.

=]

Recall... Ctrl+O
Save Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

Acquisition data info

Measurement data info

Print... Ctrl+P @

Print Preview

Prezet (Main)
Maore presets »

Exit

2838013
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2. Fill out the details in the Print dialog box,
and then click OK.

The Print dialog box is the standard
Microsoft Windows Print dialog box. The
printer controls are dependent on your
printer.

Ink Saver Mode

Operation

Print |E| E|
Printer

Name:

Status:

Ready
Type: Microzoft Office Document Image ‘witer Diriver
where:

Comment:

Microsoft Document Imaging 'iter Port:

[ Priett to file

Frint range

®al

=

Copies

Nurber of copies: 1 $

Ijl Collate

1909038

[ 1wl 1

() Selection

You can print screen images with a white background.

1. Select Options from the Tools menu.

2. Select the Colors tab in the control panel.

Toolz | Window  Help

¥ Search.

Alignments...

Diagnostics

Ihstall Uperades..

L Cptions o—:—-.

Options

© CF: 1.50000 GHz

B File View Run  Markers Setup Tools Window Help a %
3. Set the Color Scheme to Blizzard. © Freq: 150000GHz  © Reflev: 0.00 dom
The background color changes from N e e s
black to white in the graphs. o s
100de
 RBW:
300 kHe
] vBw:
-100.00 dBm Data from uncalibrated instrument

| Save and Export | GPIB | Security | Colors |

& Span: 40.00 MHz

Color scheme: | Blizzard ¥

(5]

Stopped

Simulated data SIM_NB.igt, SIM_WB.igt

Real Time  Free Run

Ref: Int | Atten: 25 dB
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Saving Data

You can save different types of data for future use.

1. Select Save As. from the File menu to [Fie ]
open the Save As dialog box. & rel... crl+a
& save ctrl+s
| Save As... ! @
Data properties... %_‘
&h Print... Ctrl+P
Print Preview
3 Preset
Application Presets. ..
Exit
1909039
2. Navigate to the folder where you want g 2[x]]
to save the setups, or use the default Save n | £ ASAB100A Files J 0drE
location. sz = 5ample Data Records @
. My Recent
3. Enter a file name. DLﬁ‘
4. Select the type of file to save. (See e
Table 6.)
. My Documents
5. Click Save. @ @ @
8
My Computer
‘l’] File name: Stabe Setup 10-31-06. Setup v Save
MyNewok  Saveastpe | Setupies v
1909-040
Table 6: File types for save
File types Description
Setup files Saves all of the setup information for all settings displays, except those settings that

are specified under the Tools menu (Alignments and Options) or in the Config In/Out
control panel.

Results Export files Saves the trace and numeric data for the selected display. The trace and numeric data
are saved in CSV format as text files.

Picture (PNG/JPG/BMP) Saves a graphical representation of the screen in the specified format. This option is
useful for including the graphic in reports or other applications. Marker readouts and
other information are included.

Selected Trace Saves a trace for later recall back into the display from which it was saved.
Data (acquisition data and Saves data for reanalysis by the RSA6100A Series or RSA5100A Series analyzer or as
acquisition data export) CSV (comma-separated value) or MAT (Matlab) format to use with external software.
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Operation

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

m  Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.

Recalling Data

You can recall and reanalyze acquisition data and setup files previously saved by the RSA6100A Series or RSA5100A

Series analyzer.

1. Push the Recall button on the front panel

. File
or select Recall from the File menu. |
| Recall.. Cirl+0 &
B Ssave Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

Acquisition data info

Measurement data info

Print... Ctrl+P

Print Preview

Preset (Main)

Mare presets »

Exit
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2. In the Open dialog box, browse to the
location of the file.
Open El@
3. Ifyou do not see the file, select the type Looki: | £ ASASTO0A Fles 9 o2
of file under Files of Type. D (S
My Fecent
4. Double click the file name to load the file. D[ﬁl
De;ktup
2 ® @
g9
My Computer
i,'] File name: \ v o)
MyNe‘Jmk Files of type: | Setup files v| Cancel

1909-042

Quick Tip

If you recall a trace that has an x-axis range that does not fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.
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Advanced Techniques

This section contains advanced operating techniques. For examples of practical applications, see the RSA6100A Series
Real-Time Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers Application Examples Manual.

Setting Up Triggering

The RSA6100A Series Real-Time Analyzers and RSA5100A Series Real-Time Analyzers offer real-time frequency domain
triggering (options 02 and 52) and frequency edge triggering in addition to power-level triggers, line trigger, runt trigger, and
external triggers. It uses a trigger event as a reference point in time for the seamless acquisition of the signal. This allows the
analyzer to store both pretrigger and posttrigger information.

The analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:

®  RF Input

® Trig In

B Trig2ln

= Gated

® Line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input

as the trigger source, you can chose from two trigger types:

DPX Density Triggering. This trigger type enables the instrument to capture any signal you can see in the DPX display,
including difficult to see signals hiding beneath other signals that have a higher amplitude or a greater repetition rate. Using
the Trigger On This™ feature, you can draw a box around the area of interest in the graph, set a Density threshold, and
the instrument will trigger when the measured Density exceeds your threshold.

Time Qualified Triggering. Time Qualified triggers allow you to trigger the instrument based on when signal transitions
occur in time. You can apply time qualification to the basic trigger types. For example, if you select the Power type and
configure it to trigger on a rising edge, Time Qualification allows you to screen rising-edge events based on how long the
signal stays high after it exceeds the trigger threshold. You may wish to trigger only on pulses that last longer than a
specified time or shorter than a specified time. You can set Time Qualified to accept only pulse widths between two specified
values, or outside of these two values.

You can also time qualify Frequency Edge, Frequency Mask, DPX Density, and Runt trigger events. For each trigger type,
the instrument finds all events that meet the basic trigger criteria, then further tests them against your time qualification
parameters.

Frequency Edge Triggering. Frequency Edge triggering triggers the instrument on time-domain signal characteristics.
The incoming data is compared to a user-selected level in Hertz. Frequency edge trigger is similar to Power triggering,
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except you also need to set a power threshold to avoid triggering on the apparent frequency fluctuations that occur at low
amplitude. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

m Position and Delay parameters that define where a trigger occurs within the acquired data record and whether to
delay the trigger for a set amount of time.

= Whether a single event can trigger an entire sweep, or each segment of the sweep requires a new trigger event in
swept acquisition mode.
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Accessing Trigger Parameters

1. Click Trig to open the Trigger control 1\ Tek RSA6100A - [Spectrum] [BEE
panel File Wiew Run Markers Setup Tools Window  Help - 8 X

| Trig o Freq: 91.49 MHz > RefLev: -50.00 dBm Replay
18909-043

@

2. As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters. -
Trigger Event | & Time Qualfied | Advanced
3. Use the Event tab to set parameters that ®Free Run o 5‘®”R Level: [10.0 cBm
. . nput » e | -
define trigger events. The parameters o :
. . rggere Type: [ Time-domain BW:
vary depending on the trigger Source oo 5] OFl pcnzt 40.00 bz
and Type selections. :
1908044
4. Use the Time Qualified tab to set
parameters that qualify trigger events
based on their time duration. , —
Trigger Event| ® Tme Qualfied | Advanced
@ Free Run © None

Time 1: 10.000 us

O Triggered (O shorter O Inside J;—
© Longer O outside 73;
1908045
5. Use the Advanced tab to select whether

to trigger on each segment while in @
Swept acquisition mode and to.s;et _— T o
parameters that control the position of
the trigger event. OFsein | on: [13% Dttt (12

O Triggered F
Delar: 02
[] Trigger each sagment of Swept acquisitions

requires trigger signals across entire Spar

1908046

Quick Tip
B Other ways to access the Trigger control panel:
= Push the Trigger button on the front panel.

= Select Trigger. from the Setup menu.

Setting Up a DPX Density Trigger

The DPX Density trigger captures transients partially obscured by other higher-amplitude or more frequent signals. If you
can see it in the DPX bitmap, you can trigger on it. The DPX Density area measurement is used to select the region of
interest in the display and to measure its current density. You set a density threshold, and the instrument triggers when the
density measurement exceeds your threshold.
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The quickest way to set up a DPX Density trigger is to use a mouse and right-click on a signal of interest in the DPX
graph, or press on the screen and hold with your finger for one second. A menu will pop up. Select Trigger On This.
This action performs several tasks:

B Places the density measurement box at the click point

B Sets the measurement box to its default size

B Measures the average density in the box

= Sets the Trigger mode to Triggered

®m  Selects the DPX Density "Higher" trigger type

m  Adjusts the trigger threshold to a density value slightly below the current measured value
®  Starts the acquisition process

To optimize DPX Density trigger settings for your particular signals, open the Trigger control panel. Use the controls for
changing the polarity of the trigger’s threshold comparison (Higher versus Lower), the Threshold value, and the size and
location of the measurement box. Use the Frequency and Amplitude settings to locate the center of the box, and set the +/-
values to adjust the width and height of the measurement box.

For events that are partially masked by stronger signals, you will often need to adjust the density Threshold based on
density measurements of the event of interest and of the obscuring signal. For example, if the density of the background
color representing only the stronger signal is 7% and the density measurement including both signals is 9%, you would
set the Threshold to 8%.

50

I Tek RSA6100A - [DPX Spectrum] EI@‘S'

Fle View Run Markers Setup Tools  Window  Help -8 x
ID\sp\avﬂ IMarkers“Sett\ngﬂ Trig || Aca || Ana | ¢ Freq: 2.05119 GHz = ReflLev: 0.00 dBm
+  Bitmap [¥]Show File:sweep and pulse.

@ -15.51 dBm
= dB/div:
10.0 dB
& RBW:
300 kHz

T e T P —

-115.51 dBm

© CF: 2.05119 GHz © Span:40.00 MHz

If your expected signal is a continuous tone and you want to capture events when it hops to a different frequency or drops
to a lower amplitude, move the Density measurement box to surround the peak of the signal, select Lower in the Density
control, and set Threshold to 100%. The instrument will trigger when the signal is absent from the measurement box.

Hint. The density measurement is the average of the densities for each column of pixels in the box. If your measurement
box is wider than the peak of a CW signal, the density reading will be less than 100%. To get a 100% reading, you can
broaden the peak by increasing RBW or narrow the box until there are no colored pixels either above or below the box. The
signal should enter the left side of the box and exit the right side. It should not cross the bottom edge of the box.
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Creating a Frequency Mask

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

You can create a Frequency Mask by using either the manual or Auto Draw method. The following procedure explains the
manual method. For a procedure on how to use the Auto Draw method, see the topic Mask Editor (Frequency Mask
Trigger) in the online help.

1. Click Trig to open the Trigger control 2 Tek RSAG100A - [Spectrum] AEE
panel Fie View Run  Markers Setup  Tools  Window  Help -8 x

| Trig © Freq: 91.40 MHz > RefLev: -50.00 dBm
18909-043

@

2. Select the Event tab in the control panel. @ @ @ @
3. Set the Source to RF Input.
Trigger Event ‘ @ Time Qualified | /dvanced
4. Set the Type to Frequency Mask. _ sz
yp q y © Free Run S:::Z.ut . oT OT>F OT=F>T Mask Editor

5. Click Mask Editor to open the Mask Oageres | oF  OpT  OPTF

Editor. Frequency Mask @Wue lese RBW: 300 ksz_| ] Auto

The Mask Editor opens with the traces of oo

the Spectrum display in the graph.

6. Click New in the tool bar. This removes
the existing mask and then creates a

Mayx Editor - Mask1

default 6-point mask. Fie

Reference: |Spectrum Trace 1 v

Mew l Open l | Save
T PHIEITE X Margin: 5.000 MHz
Next X
raph to:
arae (& Edit Points

Save As...l l Done

(to be in list, a trace must be showing in a display)

¥ Margin: 10.000 dB

Offset Freq Amplitude

0.00 dBm

-19.990 MHz -30.00 dBm
-8.000 MHz -30.00 dBm
-4.000 MHz -10.00 dBm
4.000 MHz -10.00 dBm
100.00 dBm 8.000 MHz -30.00 dBm
19.990 MHz -30.00 dBm

CF: 1.500 GHz Span: 40.00 MHz

1903048
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7. Click any point in the mask to select it.

The frequency and amplitude of the
selected point are highlighted in the
graph.

8. Edit the point by doing one of the
following:

® Drag and drop the point with the
mouse.

B Enter the frequency and amplitude in
the table.

B Adjust amplitude with the up/down
arrow keys and frequency with the
left/right arrow keys.

Quick Tips

Mask Editor - Mask1 EExR
File
B -
Maw ] [ Open I Save Save As... | I Done peleiencey Spoctum Trace L
(to be in list, a trace must be showing in a display)
T PHIEEETE X Margin:[5.000 MHz
graph to: *
& Edit Points

¥ Margin:| 10.000 dB

0.00 dBm

.

1 Olfset Freq Amplitude
|""‘.l".||lﬂ‘|r"\ ; \I..'fl.u"'gl"""' -191990 MHz -30.00 dBm
W |l|l1‘ b 8.500 MHz -30.00 dBm
4000 MHz -10.00 dBm
4,000 MHz -10.00 dBm
100.00 d&m) 8.000 MHz -30.00 dBm
19,890 MHz -30.00 dBm

CF: 1.500 GHz Span: 40.00 MHz

1903049

m Click Auto draw to generate a mask automatically adjusted to the Reference.

B Right click on the display screen to add a new point.

= Click Add Points and then click on the graph to add a new point in the graph.

= (Click Next to select the next point in the graph.

m  Click the X (delete button) to delete the selected mask point.

m Click Save to save the mask file and continue working with the mask editor.

= Click Open to load and edit a previously saved mask file.

Defining Trigger Conditions

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.

The choices are described in the
following table. (See Table 7.) The icons
at the bottom of the control panel identify
what is considered true or false.

2. Click Triggered.

The instrument will trigger when the
trigger conditions are met.

@

Trigger Event | ® Time Qualfied || Advanced
Violation
Source:
© Free Run oT OT>F OT>F>T Mask Editor
RF Input ~
O Triggered A @F> OFT> Load from file

Type:

Frequency Mask % @ True Falss (L

300 kHz

Auto

1908050

@
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Table 7: Trigger violations

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no violation)
after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after being

outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask, cross
outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask (no
violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when you analyze recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a [ Tek Rsa6100A AEE

Spectrum dISplay and a DPX Spectrum Flle  Yiew Run  Markers Setup Tools  Window Help

display. The highlighted title bar on the N
. . . oy ﬁ 1 )\ Spectrum |:‘@@

SpeCtrum dlsplay lndlcates that lt 1S the ~ Bitman [¥]Show On < ¢ Trace 1 [YIShow  +Peak Normal

selected dlsplay. o somncen [ o snoooem [

The check mark indicator in the upper " S0 1 e

left corner of the display indicates that = | 11 i

acquisition hardware is optimized for the |‘ H '

Spectrum display. [q \

‘,14 ']M‘\ i U m ‘H

[’

4 ¥
-n00dem R A | 1k -150.00 dBm

Autoscale o 1 el Al MHZ Autoscale % CF: 01.43 MHz Y Span: 0.67 MHz
. [reasney s Dlola o
4nalyzing Acq BW: 10,00 MHz, Acq Length: 89,120 us Real Time  Free Run Ref: Int  Atten: 10 dB Preamp

1903025

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The RSA6100A Series Real-Time Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers let you open any
combination of measurements. You can select the displays that you are interested in and the instrument will automatically set
up the appropriate analysis and acquisition parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to the frequency of
your signal and then set the span.

3. Click Displays to open the Select
Displays dialog box.

4. Select the General Signal Viewing folder.
5. Select the Amplitude vs Time icon.

6. Click Add to add the icon to the Selected
Displays list.

NOTE. Add the Spectrum display if it is not
already in the Selected Displays list.

7. Click OK to accept the changes and
close the dialog box.

sove

Touch Screen
or U M

1909-016

\/Tek RSA6100A - [Spectrum] EE)X]

File Wiew Run  Markers Sstup  Tools Window  Help .8 x

|D\splays Markers ||Settings || Trig || Acq || Ana | ¢ Freq: 91.49 MHz

© Reflev: -50.00 dBm

1909056

]\ Select Displays

Application Preset. Application Presets...

Availat|le displays:
ANPL Ay
]
Amplitude vs DPX Frequency  Phase vs
Time Spectrum vs Time Time

RF I&Q vs Spectrogram Time
Time Qverview

Choose a nation below,

Folders:

General Signal Viewing
Analog Moduletion

GP Digital Modulation
RF Measurements
Pulsed RF

Selected displays:

Spectrum

Add

@ — =]

1909-147
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8. Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

9. Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,”

all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

10. Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn’t contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.

Operation

Tek RSA6100A

File  %ew Run Markers Setup  Tools  Wwindow  Help 0

m Markers ||Settings || Trig || Acg || Ana | © Freq: |[IEEFAETH © RefLev: 0.00 dBm m
B _

w Trace 1 [“lshow  Narmal v Trace1 [Zshow  +Peak Normal
& 0.00dBm < 0.00 dém
< dB/div: < dBfdiv:
10.0 d& 10.0 dB
© Span: o RBW
110.0 MHz e
[l,
b oy I
h la,.‘ M”,’ W I ‘ ‘,q | ”,l” Y | clfrIJl ]
"” W %M | 'M"I W w
-100.00 dBm
re——— o Postion: 200005 © Scde: 2,220 us LD 3
Cikpe — 6 ® —s P — i ®—s @ CF: 19570 GHz Span: 200.0 MHz
&nalyzing AcCq BV 40,00 MHz, Acq Length: 4,440 us Swept Free Run Ref: Int  Atten: 25/d8
.I @ 1909052
Tek RSA61004 [BEE
Fle View Run  Markers 1 1 bols  Window  Help
Markers ||Settings r\"ﬁ’ﬂ/";‘m Ana | © Freq: 1.9570 GHz % RefLev: 0.00 dBm Run
_']‘; Amplitude vs Time ﬂ S q
v  Trace1 [¥lshow  Noma  Tracel [¥Show  +Peak Mormal
¢ 0,00 dem < 0.00 dem
< dBfdiv: © dBydiv:
100d8 10,0 dB
© Spar: ©REW
110.0 MHz 1M
I i Il 'N fi
i P A o T
AN AR
-100.00 dBm
I
RMS; -43,48 dBm © Position: 5,700 me @ Scale: 2237 us -100.00 dBm
Maxi -37.43 dBm @ 1.585us  Mini-66.23dBm @ 247.4ns “ CF: 1.9570 GHz © Span: 200.0 MHe

4nalyzing Acq BW: 110,00 MHz, Acq Length: 4.453 us Real Time  Fres Run Ref: Int  Atten: 25 dB

1900-063
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11. Decrease the span to 25 MHz in the
Spectrum display. Now the acquisitions

Tel RSA6100A

B

Fle Wiew Run Markers Setup  Toos  Window  Help

56

are real time again.

Markers ||Settings || Trig || Acq || Ana | © Freq: 1.95700 GHz

© Reflev: 0.00 dBm

n
12. Check the status bar readout to verify e BT il
that the acquisition is real-time. My ook
Both of the displays can run now. im 2::\1:
ity
Hﬂ i !'ﬂ i ﬂfl i i
! } H
et i i
M |‘ N'm *‘H;W " Wh u, o 'i'|‘|'.l|l||‘
-100.00 dBm
R;;‘i:‘:‘: dEm  © Position: ZD,DOGmT © Scale: 74490 us [ﬁ]ﬂdﬂm
e -42.35 dBim @ 280.7ns  Min: -74.05 dém @ 2.627 us Autoscale & CF: 195700 GHz Span; 40,00 MHz

ynalyzing Acg BYW: 40,00 MHz, Acq Length: 14.880 us

Real Time | Free Run

Ref: Int | Atten: 2% dB

3
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Searching Signals

The RSA6100A Series Real-Time Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers let you search the
Spectrum display’s trace results for changes in power level. You can identify matches crossing a power level or you can
create a mask that specifies power level and frequency range limits. You can select which trace to search and specify an
action to take when a search match occurs. Pass/Fail results from the Spurious and Settling Time measurements are also
searchable, but we will use the Spectrum trace example here.

To search a trace:

1 Open the Spectrum display o select the
Spectrum display if it is already open. Bl Fe Ven R vaiers Senp Tods vindow e Lo =

[arkers |[settings][ Tria | aca J[&n= | © Freq: 9.30047 GHz © RefLev: 0.00 dBm i

2. Select Tools > Search. v * Trace 1 Hshon _+Peck Noma
< 0.00 dBm

3. Select the Enable Search check box. S
o RBW
1 MHz
-100.00 dBm
& CF: 0.30047 GHz  Span: 40.00 MHz
Search Define | Actions
] Sggi‘i Search in: |Spectrum: Trace 1 A

@ Search for: |is greater than R -20.00 dBm

4. Select the trace you wish to search from
the Search in drop-down list box.

. . B Fle View Run| Markers Setwp Tools Window Help = X
5. Verify that the trace you selected in the
' . Warkers ][ | ettings][ Trig | Aca J[an2 | @ Frea: 9.30047 GHz 9 RefLev: 0.00 dBm
Search in list is the selected trace and v e
that the Show box is checked. “ 0.00 cém
< de/div:
10.0 d8
< RBW
1 MHz
-100.00 dBm
% CF:9.30047 GHz =~ Span:40.00 MHz
Search Define | Actions
SE::}[‘E Search in: | Spectrum: Trace 1 v
Spectrum: Trace 1
Search for: |2Pectrum: Trace 2 -20.00 dBm
Spectrum: Trace 3
Spectrum: Math Trace
ectrum: Spectrogram Tjace

I Tek RSAG100A - | gpectrum]

1908-134
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Specify what to search for by making a
selection from the Search for drop-down
list.

To search for signal levels above or
below a specified level, select either is
greater than or is less than.

To search for signal levels that vary with
frequency, select either is outside mask
or is inside mask. To specify the limits

in the search mask, click the Edit limits
button.

The orange shaded area in the graph
display shows the levels which, if
occupied by the signal, will constitute a
match.

)\ Tek RSAG100A - [Spectrum] [(=1(E3

Bl Fle View Run  Makers Setup Tools Window  Help - @3
Markers |[Settings]( Trig |[Aca J[ans | © Freq: 9.30047 Ghz © Reflev: 0.00 dBm [Run ]
N v Trace 1 [“]show  +Peak Normal Cl
< 0.00 dBm
< dB/div:
10.0 de
© RBW
1 MHz
-100.00 dBm
o CF:0.30047 GHz % Span:40.00 MHZ
Search Define | Actions
Enable
Saar:h Search in: | Spectrum: Trace 1 v
Search for: |is greater than v -20.00 dém
is greater than k
is less than
is outside mask

inside mask
@ 1909-121

Display with greater than search selected

I Tek RSA6100A - [Spectrum]

EEX

B0 Fle View Run  Markers Setwp Tools  Window Help = G
Warkers |[settings [ Trig [ Aca J[Ana | ¢ Freq: 9.30047 GHz ¢ RefLev: 0.00 dBm
< “ Trace 1 [¥IShow  +Peak Normal e
< 0.00 dBm
< defdiv:
10.0 d8
< REW
1 MHz
-100.00 dBm
% CF:9.30047 GHz =~ Span: 40.00 MHz
Search Define | Actions
i
Enable
Sear[h Search in: |Spectrum: Trace 1 A
Search for: |is outside mask R _Edrtlmw:s.‘.

1909137

Display with outside mask search selected
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7. Click the Actions tab to specify what
actions the analyzer should take when a
match occurs.

The analyzer can take up to five actions
when a match occurs, depending on the
run mode. In Run mode, the analyzer
can sound a beep, stop acquisitions,
save acquisition data, save trace data,
and save a picture of the display. In
Replay mode, it can sound a beep and
stop analyzing.

8. To have the analyzer take an action
when a match occurs, select the desired
action.

You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

9. Click the close box to remove the Search
control panel.

10. Press the Run button to initiate a search.

Red lines appear in the graph display
when there is a match on incoming data.
Click the Replay button on the toolbar
to initiate a search on the current data
record.

Operation

U\ Tek RSA6100A - [Spectrum] [(=)[E3]
B0 Fie  View Run  Markers Setup  Tools  Window  Help = &8
Warkers || Settings || Trig || Acq || Anz | © Freq: 9.30047 GHz % RefLev: 0.00 dBm
< “ Trace 1 [¥IShow  +Peak Normal
% 0.00 dBm
< dB/div:

10.0 dB
“ RBW

1 MHz

-100.00 dBm

© CF:9.30047 GHz © Span:40.00 MHz
Search Define | Actions =
Enable During Run or Replay During Run enly

v

Search
on match: []Beep [] AutoSave acquisition data
[1Stop [] AutoSave trace
© ] AutoSave picture

O

1909135

I Tek RSA6100A - [Spectrum]

==

B Fle View Run  Markers Setwp Tools  Window Help

Warkers |[settings ][ Trig ][ Acq [ Ana | ¢ Freq: 9.30047 6Hz & RefLev: 0.00 dBm |
|

< “ Trace 1 [¥IShow  +Peak Normal -

< 0.00 dBm

< defdiv:

10.0 d8

< REW

1 MHz

-100.00 dBm

o CF: 930047 GHz

© Span:40.00 MHz
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Using Correction Tables

The RSA6100A Series Real-Time Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers let you correct the
signal displays and measurement results to account for gains and losses in external equipment. You can specify a single
gain value or you can use an external loss table to adjust the gain/loss value based on frequency.

To specify external gain/loss corrections:

1. Press the Ampl button to display the
Amplitude control panel.

2. Select the External Gain/Loss Correction
tab.

3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box.

I Tek RSA6100A - [Spectrum]

NOTE. You can enter either positive or
negative gain values. Positive values
represent a gain. Negative values represent
a loss.

4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables.
You can enable all three external loss
tables at the same time. Thus, you could
use different external loss tables for an
antenna, a preamplifier, and for cabling.

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.

60

B Fle View Run  Markers Setwp Tools  Window Help = @8
Warkers || Settings || Trig || Acq || Ana | @ Freq: 9.30047 GHz < RefLev: 0.00 dBm E @
'  Trace 1 [FShow  +Peak Normal ar
< 0.00 dBm
< de/div:
10.0 dB
© RBW
1 MHz
-100.00 dBm
© CF: 9.30047 GHz © Span:40.00 MHz
Amplitude Internal Settings | External Gain/Lass Correction | External Probe Corraction
O : ‘ 00dE External Loss Tables (Loss > 0, Gain < 0)
External Gain value: |0.
0
Apply table corrections to:
O All acquired data (filter method) [}
-, Traces in Spectrum, Spectrogram, Spurious
© and Ampl-vs-Time o
1908130
Amplitude Intern|| Settings | External Gain/Loss Correction | External Probe Correction
o : . i Extemal Loss Tables (Loss > 0, Gain < 0}
V| External Gain value: |0.
a
Apply table corrections to:
O Al acquired data (filter method) o
“Tra[es in Spectrum, Spectrogram, Spurious -
O and Ampl-vs-Time |
1909122
Amplitude Internal Settings | External Gain/Loss Correction | Externz| Probe Correction

External Loss Tables (Loss = 0, G in < 0)
[ External Gain value: (0.0 dB

[¥] |Ext Loss Table 1 Edit...
Apply table corrections to:
© Al acquired data (fiter method) ]
-, Traces in Spectrum, Spectrogram, Spurious
®© and Ampl-vs-Time ]

1909123
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6. Edit the contents gf .the table to match L e
the loss characteristics of the equipment
you are go_rrectmg for. Click OK when X Frequency BN A
you are finished. 5.500000 GHz -1.023000 dB

NOTE. You can enter either positive or S —
negative values into the table. But in contrast
to the External Gain value setting, positive

values represent a loss and negative values O e Cection)
represent a gain.

@ Linear

For detailed information on using the Table
Editor, select Help > User Manual and look
in the Index for External Loss Tables.

sers| [ | [ o || o

New Tab\e] l Load... ]

1909151

7. You can change the fitle for each external

loss table. Select the title box and type B0 Fle Ven Run  Markers Sewp Tools Window  Heb -8 x

in a new t|t|e Markers || Settings m[m[m & Freq: 9.30047 GHz < ReflLev: 0.00 dBm Run
. . . J ~ Trace 1 [IShow  +Peak Normal e

Note that the title is only a label. It is © 000 cam

not tied to the file name of any table you o

have loaded or saved. oraw

8. Specify whether table corrections are
applied to all acquired data or only to
traces in the Spectrum, Spectrogram,
Spurious and Amplitude vs Time

-100.00 dBm

diSplayS. © CF: 2.30047 Gz © Span:40.00 Mz
Corrections applied to data are Ampliude - mama seings| Eteralal/Los Gomection | ans fabe Gpecten
performed in real time using the digital O el Gan v (000 e

filter capabilities of the instrument. While e e o Pree

this has the advantage of correcting (o e Spechum, Specogam, SSUIes [ g @

the data for use in all measurements,
digital filtering is limited in its ability to o2
apply corrections that change rapidly in @

amplitude over small frequency ranges,

as may occur when switching between

two antennas. When this happens,

the filters may result in an amplitude

correction that appears to ring in its

response, resulting in poorly corrected

data. For that reason, the RSA offers

trace-only correction for spectrograms,

spectrum, spurious, and amplitude vs.

time displays. These trace corrections

are similar to those applied in traditional

spectrum analyzers, and should be

used when discontinuities occur in the

amplitude/frequency correction table.
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When choosing whether to correct
sample data or traces, keep the following
in mind:

If sample data is acquired while

data correction is enabled, that data
record is permanently corrected. If the
acquisition is saved and recalled, the
recalled acquisition includes corrections.
Corrections are not saved separately
from the raw data; they are used during
the acquisition process to adjust the data
values.

Trace corrections can be applied

at any time, as they are part of the
measurement’s computations. Using
Replay will apply trace corrections to
a trace if this control is enabled (and
an external loss table is specified and
enabled).

Be aware that if you recall acquisition
data that was saved with data corrections
and you use Replay with trace
corrections selected and an external
loss table enabled, the trace will be
calculated using corrected data and also
corrected with trace corrections. This
usually creates incorrect traces.

. Click the close box to remove the

Amplitude control panel when you are
finished making changes.
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Using Audio Demodulation

Operation

The RSA6100A Series Real-Time Spectrum Analyzers and RSA5100A Series Real-Time Signal Analyzers can demodulate
audio signals, which can help you to identify unknown radio signals. You access the Audio Demod tab from the Settings

control panel of the DPX Spectrum plot display.

To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX display will open.

5. If necessary, select the Spectrum plot
from the drop-down list.

6. Press the Settings front-panel button to
display the DPX Settings control panel.

7. Click the Audio Demod tab to display
the Audio Demod control panel.

[l Select Displays E @ El

Folders:

General Signal Viewing
Analog Modulation

GP Digital Modulation
RF Measurements
Pulsed RF

Selected displays:

Spectrum

Choose any combina@, oruse an App@reset. Application Presets...

Available displays:

AMPL

il
Amplitude vs DPX
Time Spectrum

Frequency  Phase vs
vs Time Time
RF 1&Q vs Spectrogram Time
Time Overview
Add

@

(o] (o=

1900-148
I\ Tek RSA6100A - [DPX Spectrum] D EE
Fle Wiew Run  Markers Setup  Tools  ‘Window  Help -
Displays | | Markers ||Settings || Trig || Acg || Ana | © Freq: 91.50 MHz < ReflLev: 0.00 dBm
v v +Peak Tr [Cshow  Off
= -40,00 dBrn
= dBfdiv:
£.50 di
© REW
100 k2 - A
-105.00 dBm =
o CF: 91,50 MHz © Span: 10.00 MHz
DPX Spectrum | Freq & Span | BW | Traces | Scale | Prefs | Densty | Aucw Demoad
Settings

off

Defaults

Analyzing

RSAB6100A Series & RSA5100A Series Quick Start User Manual

A By 10,00 MHz, Acg Length: 44.640 us

Tune with: | Selected Marker ¥
A“d‘i Receiver Freq:  91.5 MHz
Gain’
FM 3 -
- Receiver Bwy; | 30.000 kHz

* Sound level is also affected by Windows volume control.

Real Time  Free Run Ref: Int  Atten: 25 dB Preamp

1900-126

63



Operation

64

8. Click the On button to enable audio
demodulation.

9. To specify the demodulation type, click
either the AM or FM button.

NOTE. Note that the AM and FM buttons
select only the demodulation type; they do
not specify a frequency band.

10. Set the center frequency as needed.

The receiver frequency (frequency to

be demodulated) is specified with either
markers or the frequency control (the
front panel Frequency button or the Freq
control in the toolbar). Use the Tune with
setting to specify whether markers or the
frequency control is used to specify the
receiver frequency.

11. Select either a marker or frequency
control from the Tune with drop-down
list.

12. If the marker you select is not enabled
(it will be visible in the display if it is
enabled), click the Markers button in the
toolbar to display the Markers toolbar.

0

DPX Spectrum | Freq & 5pi|1 | BW Prefs | Densty | Audio Demod

Settings

Traces || Scale

Tune with: | Selected Marker |+
K
Audio Receiver Freq:  91.5 MHz
Gain®
m 30,000 kHz
L>

Receiver BW:
Restore
Defaults * Sound le|rel is also affected by Windows volume control.

1909127

=)

DPX Spectrum | Freq & Span | BW | Traces|| Scale | Prefs | Density | Audio Demod

Settings [————————===
| Tune with: | Selected Marker v 1
“ T
Audio L:.::. e e e
. - o
o] M . |marker Mz
L Recelver BW: | \-rer Ma

Selected Marker
* Sound level is also affected by Windows v[Freq contral

1909-129

| 7\ Tek RSA6100A - [DPX Spectrum] @E\

BN Fie View Run  Markers  Setup  Tooks  Window  Help -8 x
Displays | | Markers ||Settings || Trig || Acg || Ana | © Freq: 91.500 MHz <~ Refley: 0.00 dBm
v v +Peck Tr [show  Off
© .37.50 dBrn
< defdiv:
7.00 de
~ RBW
254z
-107.50 dBm
© CF: 91,500 MHz © Span; 2,500 MHz
DPX Spectrum | Freq & Span | BW | Traces | Scale | Prefs | Density | Audio Demod
Settings
Tune with: | Marker MR v
Receiver Freq:  88.5 MHz

Audig
Gain*®

* Sound level is also affected by Windows volume control.

Receiver gw; |30-000 kHz
Defaufts

Analyzing Acg BW: 2,50 MHz, Acq Length: 222,720 us Rea Time  Free Run Ref Int  Atten: 25 dB Preamp

1990-138
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13. Click the Define button in the Marker

toolbar to display the Define Markers

@

Operation

COﬂtl'O| panel a(:f:;:h Marker Properties | Define Peaks
Reference Delta Markers
14. Click Add to add markers as needed. L] | wower e
(insatacted | L7k
display)
Readouts: | Absolute 5

Al Off

Markers | Define | «» MR

12)

15. Click the Settings button to return to the
Audio Demod control panel.

" Tek RSAG1004 - [DPX|Spectrum]

Bl Fie  vew Run  Harkers

Frequency ¥ |1.4958 GHz

[reere] (7o) (€ () &) [(8) ) (3

1900-128

Setup  Tools  Window  Help

x

Settings Y Freq: 91.50 MHz

% Reflev: 0.00 dBm

<

-107.50 dBm

Define
Markers

Al Off
Markers v MR

Marker:
Attach to:
(in selected
display)

Analyzing

« +Peak Tr [Jshow

& CF: 91,50 MHz

Marker Properties | Define Paaks

Off

f ] A
Y
f

1t ,; A S
vy v Y W e

& Span: 10,00 MHz

Reference Delta Markers
MR, M1 M2 M3 M4
v
Readouts: | Delta -

Frequency (91,5 MHz

(] () O B E & m)

Acq BW: 10,00 MHz, Acq Length: 44.640 us Real Time | Free Run Refi Int  Atten: 25 dB Preamp

1909131

16. Set the required receiver bandwidth by B e & cona] . L] st L ace L panemy] s o |
entering a value into the Receiver BW settings

value entry box.

RSAB6100A Series & RSA5100A Series Quick Start User Manual

Tune with: | Marker MR v
Receiver Freq:  88.5 MHz
30.000 kHz

Receiver BW:

* Sound level is also affected by Windows volume cor | rol.

s)

1900-132
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17. Set the receiver frequency.

18.

If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. Fine tune the marker
position with the front-panel knob or
your mouse wheel. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.

The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.

T Tek RSAG100A - [DPX Spectrum] [BEE
Bl Fie ¥ew Run  Markers Setup  Tools  Window  Help -8 X
Y Freq: 91.50 MHz o RefLev: 0.00 dBm
< w +Peak Tr [lshow  Off

& -37.50 dBm

= dB/div:

7.00dB

~ RBW

100 ki

-107.50 dBm

© (F 91,50 MHz & Span; 10,00 MHz

DPX Spectrum | Freq & Span | BW | Traces | scale | Prefs | Densty | Audio Demod

Settings

Tune with: | Marker MR v
“
Audio Receiver Freq:  91.5 MHz
Gain™
off FM 3 z
Receiver Bw; |30-000 kHz
-

* Sound level is also affected by Windows volume control.

e e y sl | (e (o) (6 B) (8 (8 () ()
Analyzing Acg BW: 10,00 MHz, igth: 44,640 us Real Time  Free Run Ref: Int  Atten: 25 dB Preamp

1900133
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A

Accessories
documents, 1
optional, 4
power cords, 2, 3
Product Documentation, 3
standard, 1, 3

Acquisition
conflicts, 54
controlling, 53
data source, 28
starting, 36
stopping, 36

Analysis window, 27, 29

Application presets, 31

audio demodulation, 63

C

CF Pan

Touchscreen actions menu, 40
check mark indicator, 25, 53
Cleaning procedures, 15
Conflicts

measurement, 54
Connectors

front panel, 20

rear panel, 21

RF signal input, 35, 36
Controlling acquisitions, 53
Controls

display-specific, 26

front panel, 16

interface, 23
Cooling clearances, 7
correction tables, 60

D

Data

recalling, 45

saving, 44
Default settings, 34
Diagnostics, 14
Digital demodulation displays, 29
Display

conflicts, 54

Display properties
changing, 13
Display settings
changing, 33
Displays
general signal viewing, 29
GP digital modulation, 29
printing, 42
Pulsed RF, 29
RF measurement, 29
selecting, 30
Documentation, ix
Tektronix part numbers, 1,3

E

Environmental specifications, 7
altitude, 7
cooling clearances, 7
humidity, 7
temperature, 7
Extended desktop, 10
external gain/loss correction, 60
External monitor, 10

F

Features, ix
File types, 44
Free Run trigger mode, 47
Frequency mask
Mask Editor, 51
triggering, 47
Front panel
connectors, 20
controls, 16

G

General signal viewing displays, 29
Graphics driver, 13

Incoming inspection, 14
Information messages, 32
Ink saver mode, 43
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Input requirements
frequency range, 35
input impedance, 35
power, 35
RF signal range, 35
voltage, 35

Installation, 1
network connections, 8

Italicized numbers, 26

K

Key features, ix

Maintenance
cleaning procedures, 15
repackaging, 15
Marker toolbar, 39
Markers, 37
absolute, 38
adding, 39
defining, 40
delta, 38
DPX bitmap trace, 38
shapes, 38
Mask Editor
adding points, 51
editing points, 52

Measurement

conflicts, 54
Mechanical specifications, 7
Messages

on-screen, 32
MR, 38

N

Network connections, 8

0]

Optional accessories, 4
Options, 5
Power cords, 2, 3

Index
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P

Pan

Touchscreen actions menu, 40
Part numbers, manuals, 1, 3
Power cord options, 2, 3
Power level triggering, 48
Power supply, 7
Preset, 34

selecting displays, 31

system settings, 34
Printing, 42

ink saver mode, 43
Product features, ix
Pulsed RF displays, 29

R

Real-Time spectrum analyzer, 27
Rear panel connectors, 21
Recalling data, 45
Repackaging, 15
Reset scale

Touchscreen actions menu, 40
Returning the instrument, 15
RF measurement displays, 29
RF signal connections, 35, 36
RF signal input range, 35
Run control, 36
Run menu, 36

S

Safety Summary, iii
Save options, 44
Saving data, 44
Screens, printing, 42
Search, 57

68

Select
Touchscreen actions menu, 40
Selected window, 53
Selecting displays, 30
Settings
changing, 33
default, 34
preset, 34
Setups
recalling, 45
saving, 44
Software upgrades, x
installing, 15
Span Zoom
Touchscreen actions menu, 40
Specifications
altitude, 7
cooling clearances, 7
environmental, 7
humidity, 7
input requirements, 35
mechanical, 7
power supply, 7
product dimensions, 7
temperature, 7
Spectrum analyzer
real-time concepts, 27
Standard accessories, 1,3
documents, 1
power cord, 2,3
Product Documentation, 3
Starting acquisitions, 36
Stopping acquisitions, 36

.

touchscreen actions menu, 40
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Trace legend, 33
Trigger
control panel, 49
mask, 51
violations, 53
Trigger Event parameters, 48
accessing, 49
Triggered trigger mode, 47
Triggering
free run, 47
frequency mask, 47
parameters, 48
power level, 48
triggered, 47

U

Upgrades
software, x, 15

vV

Violations
trigger mask, 53

W

Window
analysis, 27
selected, 53

Z

Zoom
Touchscreen actions menu, 40
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